Photoshop Domain 1: Setting Project Requirements

TRUE/FALSE

1. A drawing based on a photograph is an example of a derivative work.
   ANS: T  PTS: 1  REF: PS 5

2. The use of the copyright notice is the responsibility of the copyright owner and requires permission from, or registration with, the Copyright Office.
   ANS: F  PTS: 1  REF: PS 5

3. Scope creep often arises in the early stages of a project.
   ANS: F  PTS: 1  REF: PS 13

4. Planning for potential issues ahead of time is one way to prevent them from occurring.
   ANS: T  PTS: 1  REF: PS 13

MULTIPLE CHOICE

1. Except in cases of ____, you must obtain permission for all protected material you want to use.
   a. copyright  c. trademark
   b. fair use  d. intellectual property
   ANS: B  PTS: 1  REF: PS 6

2. The ____ refers to how long a project should take.
   a. mockup  c. comp
   b. project scope  d. deliverables
   ANS: B  PTS: 1  REF: PS 12

3. A ____ is a prototype or design of the layout.
   a. deliverable  c. publication
   b. scope  d. comp
   ANS: D  PTS: 1  REF: PS 12
4. ____ refers to changes in the requirements of the project as the project is being constructed.
   a. Project scope 
   b. Brainstorming 
   c. Scope creep 
   d. Comp 

   ANS: C  PTS: 1  REF: PS 13

**Figure PS 1-1**

5. The accompanying figure displays example postcards created for two different ____.
   a. businesses 
   b. project managers 
   c. clients 
   d. target audiences 

   ANS: D  PTS: 1  REF: PS 4

**Case PS 1-1**

Jane is creating a plan for developing a logo for a client.

6. In which stage will Jane show a design comp to the client?
   a. Planning and analysis 
   b. Scheduling 
   c. Building 
   d. Implementing or publishing 

   ANS: C  PTS: 1  REF: PS 12  TOP: Critical Thinking

Case PS 1-2

Rodney has just finished filming a documentary about his family. He is really proud of it and thinks his is a unique story, so he wants to send it to a movie studio for review.

7. Before he sends his work to the movie studio, Rodney wonders if he should put a copyright notice on it. What do you think?
   a. No. He doesn’t need to copyright it because of the fair use doctrine.
   b. Yes. It is his responsibility to add a copyright notice because it is his original work of authorship.
   c. No. He doesn’t need to copyright it because it is a derivative work.
   d. Yes. It should be copyrighted, but he needs to get permission from the Copyright Office.

ANS: B    PTS: 1    REF: PS 5-PS 6    TOP: Critical Thinking

COMPLETION

1. _________________ is the distribution of copies of a work to the public by sale or other transfer of ownership, or by rental, lease, or lending.

   ANS: Publication
   PTS: 1    REF: PS 5

2. _________________ attaches to a work as soon as it is created.

   ANS: Copyright
   PTS: 1    REF: PS 5

3. Knowing the type of project will help you write a(n) _________________ for the scope of the job and the job requirements.

   ANS: outline
   PTS: 1    REF: PS 11

4. A list of items the project needs in order to meet the criteria that has been defined are called _________________.

   ANS: deliverables
   PTS: 1    REF: PS 12
5. Keeping individuals on task and on time is the job of the ____________________.
   ANS: project manager
   PTS: 1    REF: PS 13

MATCHING

Identify the letter of the choice that best matches the phrase or definition.

a. derivative work
b. intellectual property
c. copyright
d. fair use doctrine

1. Allows copyrighted work to be reproduced for a variety of reasons including news reporting, teaching, parody, and research
2. A work that is based on or derived from one or more existing works (and previously published)
3. A category of intellectual property providing protection to the authors of “original works of authorship,” including literary, dramatic, musical, artistic, and certain other intellectual works
4. Refers to creations of the mind and may include copyrights, trademarks, patents, industrial design rights, and trade secrets

1. ANS: D    PTS: 1    REF: PS 6
2. ANS: A    PTS: 1    REF: PS 5
3. ANS: C    PTS: 1    REF: PS 5
4. ANS: B    PTS: 1    REF: PS 5
Photoshop Domain 2: Identifying Design Elements When Preparing Images

TRUE/FALSE
1. Resolution is measured in lines per inch (lpi); the lower the resolution, the more pixels per inch.
   ANS: F PTS: 1 REF: PS 16
2. Cropping allows you to remove the outside portion of an image to correct its focus.
   ANS: T PTS: 1 REF: PS 17
3. An image composition is the arrangement of the visual elements of your image to create a visually compelling design.
   ANS: T PTS: 1 REF: PS 22
4. When you are submitting your graphic design to be printed, it is important to convert your document to the RGB color mode.
   ANS: F PTS: 1 REF: PS 27

MULTIPLE CHOICE
1. Increasing the number of pixels is referred to as _____, and usually results in inferior image quality because of a loss of detail.
   a. interpolation  b. downsampling  c. upsampling  d. cropping
   ANS: C PTS: 1 REF: PS 16
2. The resolution on a printer is measured in ____.
   a. pixels per inch (ppi)  b. dots per inch (dpi)  c. lines per inch (lpi)  d. none of the above
   ANS: B PTS: 1 REF: PS 17
3. Colors that are in a range that can be displayed or printed are referred to as a ____.
   a. gamut  b. typography  c. bitmap  d. resolution
   ANS: A PTS: 1 REF: PS 28
4. Photoshop supports ____ images, which allow a photographer to record a much larger range of tonal detail than can be captured in one photo.
   a. bilinear  b. CMYK  c. RGB  d. HDR
   ANS: D PTS: 1 REF: PS 30
5. Figure PS 2-1 best shows an example of ____.
   a. a raster image       c. field of view
   b. visual hierarchy     d. unsampling

   ANS: B       PTS: 1       REF: PS 25

Case PS 2-1
Jake is laying out a graphic design project and trying to keep in mind design elements, design principles, and image composition.

6. Which design principle is Jake implementing when he places the most interesting component of the composition off-center?
   a. Color theory       c. Unity
   b. White space        d. Rule of Thirds

   ANS: D       PTS: 1       REF: PS 21       TOP: Critical Thinking

Case PS 2-2
Sophie is using a digital SLR camera with a 3:2 aspect ratio for a portrait project in her photography class.

7. Which size photo could Sophie print without having to crop the image?
   a. 5” x 7”       c. 8” x 12”
   b. 8” x 10”       d. any of the above

   ANS: C       PTS: 1       REF: PS 23       TOP: Critical Thinking

COMPLETION

1. A(n) ____________________, short for picture element, is a single point in a picture laid out in rows and columns.

   ANS: pixel
   PTS: 1       REF: PS 16

2. Photoshop uses a method called ____________________ to resample an image, using existing colors to create new color values.
3. The __________________ of a photograph, or a graphic design project, is the area behind the subject, which provides context and depth to the composition, or it can be used to help isolate the main subject.

ANS: background

4. The selections made to design the text and the placement of the words are called ____________________.

ANS: typography

5. A(n) ____________________ image is created with mathematical calculations and can be enlarged without a loss of quality.

ANS: vector

MATCHING

Identify the letter of the choice that best matches the phrase or definition.

a. JPEG or JPG (.jpg)
b. GIF (.gif)
c. PDF (.pdf)
d. PSD (.psd)

1. Created by Adobe for document sharing; ensures the layout and quality will not change when opened on a different computer
2. Photoshop native file format, keeps the document editable and all layers intact
3. Supports millions of colors and can be compressed to reduce file size; often used for digital images
4. A bitmap image format for pictures with up to 256 distinct colors; supports transparency

1. ANS: C  PTS: 1  REF: PS 18
2. ANS: D  PTS: 1  REF: PS 18
3. ANS: A  PTS: 1  REF: PS 18
4. ANS: B  PTS: 1  REF: PS 18
TRUE/FALSE

1. Painting tools paint pixels on a blank canvas or in an image.
   
   ANS: T     PTS: 1     REF: PS 40

2. Destructive editing does not alter the original image data or degrade the image.

   ANS: F     PTS: 1     REF: PS 45

3. You can open an image as a Smart Object.

   ANS: T     PTS: 1     REF: PS 53

4. A color space is the range of colors, or color gamut, that a camera can capture, a scanner can scan, a printer can print, or a monitor can display.

   ANS: T     PTS: 1     REF: PS 55

MULTIPLE CHOICE

1. The ____ holds the workspace elements together.
   a. Live Workspace   c. contact sheet
   b. Application frame d. smart filter

   ANS: B     PTS: 1     REF: PS 36

2. The ____ is organized into the following tools categories: Selection, Crop and slice, Measuring, Retouching, Painting, Drawing and type, and Navigation & 3D.
   a. document window c. dock
   b. Tools panel      d. Layers panel

   ANS: B     PTS: 1     REF: PS 37

3. A ____ is a filter applied to Smart Objects to create a nondestructive filter effect.
   a. smart filter   c. contact sheet
   b. dock           d. mask

   ANS: A     PTS: 1     REF: PS 45

4. You can add a ____ to an image to change how pixels in the selected layer blend with pixels in the same location in the layer just below it.
   a. smart filter   c. dock
   b. blending mode  d. color gamut

   ANS: B     PTS: 1     REF: PS 48

Figure PS 3-1
5. Figure PS 3-1 displays a _____.  
   a. color gamut  
   b. smart filter  
   c. contact sheet  
   d. color space  
   ANS: C  
   PTS: 1  
   REF: PS 52

CASE STUDIES

Case #1: Cara is creating an image for a web site and wants to optimize it and view approximate download times for the image.

6. Which command should Cara use for image optimization?  
   a. Place command on the File menu  
   b. Proof Setup command on the View menu  
   c. Launch Bridge button on the Application bar  
   d. Save for Web & Devices command on the File menu  
   ANS: D  
   PTS: 1  
   REF: PS 52  
   TOP: Critical Thinking

Case #2: John has created an image in Photoshop that looked great on his monitor, but he is not happy with the way the colors looked when he printed it.

7. What term refers to the way colors are converted from John’s monitor to his printer?  
   a. color space  
   b. rendering intent  
   c. soft proofing  
   d. color gamut  
   ANS: B  
   PTS: 1  
   REF: PS 55  
   TOP: Critical Thinking

COMPLETION

1. A ____________________ is a collection of panel groups.
   
   ANS: dock
   
   PTS: 1      REF: PS 44

2. By adding a ____________________ to a layer, you can hide or reveal portions of the image in the layer that is beneath it in the Layers panel.
   
   ANS: mask
   
   PTS: 1      REF: PS 48

3. You can bring images into Photoshop using the Open command or the  ________________ command on the File menu.
   
   ANS: place
   
   PTS: 1      REF: PS 51

4. Soft proofing simulates on screen what your document will look like when ________________.
   
   ANS: printed
   
   PTS: 1      REF: PS 55

5. A ____________________ mask is dependent on the resolution of the bitmap images and you can edit it using painting or selection tools.
   
   ANS: layer
   
   PTS: 1      REF: PS 48

MATCHING

Identify the letter of the choice that best matches the phrase or definition.

a. Retouching tools
b. Measuring tools
c. Crop and Slice tools
d. Drawing and type tools

1. Vector-based tools that draw vector paths.
2. Tools that correct an image to remove image flaws such as scratches, red eye, and blemishes.
3. Tools that draw measurement lines, select color samples, and create comments.
4. Tools that separate or divide an image.
<table>
<thead>
<tr>
<th></th>
<th>ANS:</th>
<th>PTS:</th>
<th>REF:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>D</td>
<td>1</td>
<td>PS 41</td>
</tr>
<tr>
<td>2.</td>
<td>A</td>
<td>1</td>
<td>PS 40</td>
</tr>
<tr>
<td>3.</td>
<td>B</td>
<td>1</td>
<td>PS 39</td>
</tr>
<tr>
<td>4.</td>
<td>C</td>
<td>1</td>
<td>PS 39</td>
</tr>
</tbody>
</table>

TRUE/FALSE

1. To measure areas of an image, you can use tools and commands available on the Ruler menu.
   
   ANS: F   PTS: 1   REF: PS 66

2. Guides and grids are useful when you need to align elements such as text in the document.
   
   ANS: T   PTS: 1   REF: PS 71

3. Opacity blends a layer with the layer below it by reducing the opaqueness of the active layer.
   
   ANS: T   PTS: 1   REF: PS 74

4. Because working with filters results in constructive editing, you should duplicate the layer to which you want to apply a filter.
   
   ANS: F   PTS: 1   REF: PS 88

MULTIPLE CHOICE

1. Which command places the item in the approximate same position as it appeared in the original document?
   
   a. Copy Merged   b. Paste In Place   c. Place Into   d. Place Outside

   ANS: B   PTS: 1   REF: PS 62

2. Which type of repair on the options bar randomly selects pixels near the problem area to use as a patch?
   
   a. refine edge   b. proximity match   c. create texture   d. content-aware

   ANS: B   PTS: 1   REF: PS 64

3. When creating a collage of images where you want to blend one image into another, use ____ to blur the edge of the selection.
   
   a. marching ants   b. droplets   c. channels   d. feathering

   ANS: D   PTS: 1   REF: PS 66

4. Which Brush options bar emulates a can of spray paint?
   
   a. Tool preset   b. Opacity slider   c. Enable airbrush mode   d. Table pressure controls size

   ANS: C   PTS: 1   REF: PS 82

FIGURE PS 4-1
5. Figure PS 4-1 shows an image being edited ____.
   a. in Quick Mask Mode  
   b. with Localized Color Clusters  
   c. using the Healing Brush tool  
   d. in the History panel

   ANS: A  
   PTS: 1  
   REF: PS 60

CASE STUDIES

Case #1: Davy has multiple images with overlapping regions that he would like to combine into a single image for a photo mural he is creating for the school entryway.

6. Which command would Davy use to combine the separate images using a stitching effect to create one panoramic image?
   a. Batch process  
   b. Photomerge  
   c. Refine edge  
   d. Puppet Warp

   ANS: B  
   PTS: 1  
   REF: PS 67  
   TOP: Critical Thinking

Case #2: Monette is entering one of her pictures into a photo contest, but first she wants to transform the image by adjusting one or more of its physical characteristics.

7. To ____ the image, Monette would place the pointer near an edge of the bounding box, and then when the pointer changes to a curved double-headed arrow, drag the pointer.
   a. scale  
   b. rotate  
   c. distort  
   d. skew

   ANS: B  
   PTS: 1  
   REF: PS 72  
   TOP: Critical Thinking

COMPLETION
1. _________________ is the term used for an active selection.

   ANS: Marching ants

   PTS: 1    REF: PS 60

2. An _________________, also called fringing or matting, are the fringe pixels in the background that are difficult to isolate and remove.

   ANS: edge halo

   PTS: 1    REF: PS 64

3. _________________ an image combines multiple images into a single image.

   ANS: Compositing

   PTS: 1    REF: PS 66

4. If you want to repeat certain actions using multiple images, you can turn an action into a _________________.

   ANS: droplet

   PTS: 1    REF: PS 67

5. You can use the _________________ command to distort areas in an image and mimic motion.

   ANS: Puppet Warp

   PTS: 1    REF: PS 74

MATCHING

Identify the letter of the choice that best matches the phrase or definition.

a. All
b. Deselect
c. Reselect
d. Inverse

1. Reverses the selection to the opposite of what is currently selected
2. Reactivates the previous selection
3. Selects everything on the active layer
4. Removes the selection

1. ANS: D    PTS: 1    REF: PS 61
2. ANS: C    PTS: 1    REF: PS 61
3. ANS: A    PTS: 1    REF: PS 61
4. ANS: B    PTS: 1    REF: PS 61
TRUE/FALSE

1. Every user accesses the Internet with the same speed.
   ANS: F    PTS: 1    REF: PS 94

2. GIF, JPEG, and PNG files are resolution dependent.
   ANS: T    PTS: 1    REF: PS 94

3. Indexing can be used when saving a file in the JPEG format.
   ANS: F    PTS: 1    REF: PS 96

4. Because most desktop printers are configured to print from RGB mode, you do not need to convert your image to CMYK mode when using a desktop printer.
   ANS: T    PTS: 1    REF: PS 98

MULTIPLE CHOICE

1. Resolution dependent means that ____.
   a. the file format supports transparency
   b. you cannot change an image’s pixel dimensions and resolution
   c. the quality of the image may be affected by the resolution of the computer display
   d. the quality of the image is not affected by the resolution of the computer display
   ANS: C    PTS: 1    REF: PS 94

2. Which of the Color Table algorithms in the Save for Web & Devices dialog box is the default and creates a palette based on a larger range of colors?
   a. Perceptual
   b. Selective
   c. Adaptive
   d. Restrictive
   ANS: B    PTS: 1    REF: PS 96

3. Which file format supports transparency without the need of applying a matte color or using transparency dithering?
   a. GIF
   b. JPEG
   c. PDF
   d. PNG-24
   ANS: D    PTS: 1    REF: PS 97

4. You can create a web photo gallery in ____.
   a. Adobe Photoshop
   b. Adobe After Effects
   c. Adobe Bridge
   d. Adobe Premiere Pro
   ANS: C    PTS: 1    REF: PS 97

Figure PS 5-1
5. Figure PS 5-1 displays the Save for Web & Devices dialog box. Which of the four tabs displays the image without any optimization?
   a. Original  
   b. Optimized  
   c. 2-Up  
   d. 4-Up
   ANS: A  PTS: 1  REF: PS 96

CASE STUDIES

Case #1: Marie created several images on her computer and used them in a video. She is concerned that the images appear distorted when viewed on a television.

6. What setting does Marie need to adjust in the images before using them in a video-editing application to avoid the distortion she is experiencing?
   a. transparency  
   b. dithering  
   c. safe zones  
   d. pixel aspect ratio
   ANS: D  PTS: 1  REF: PS 100  TOP: Critical Thinking

Case #2: Bill has created a video for broadcast on television. He knows that computers and televisions display video differently so he wants to make sure that the content of his video can be viewed completely.

7. What does Bill need to check to make sure that content is not missed when played on a television screen?
   a. pixel aspect ratio  
   b. safe zones  
   c. drawers  
   d. indexing
   ANS: B  PTS: 1  REF: PS 100  TOP: Critical Thinking

COMPLETION

1. GIF, JPEG or JPG, and ____________________ are file formats used for web images.
   ANS: PNG
2. In Adobe Bridge, categories in a panel are referred to as ________________.
   ANS: drawers
   PTS: 1  REF: PS 98

3. To open the Print dialog box, click the Print command on the ________________ menu.
   ANS: file
   PTS: 1  REF: PS 98

4. Viewing area ________________, or margins, are designed to ensure that certain content is not missed when played on television screens.
   ANS: safe zones
   PTS: 1  REF: PS 100

5. An image’s dimensions include the size in ________________ and the resolution.
   ANS: pixels
   PTS: 1  REF: PS 94

MATCHING

Identify the letter of the choice that best matches the phrase or definition.

a. Indexing
b. Optimizing
c. Dithering
d. Algorithm

1. Lessens the appearance of random noise in your image that may occur when working with transparency by creating dots of color along the edge of the image.
   1. ANS: C  PTS: 1  REF: PS 97

2. Reducing the file size by removing colors from the index.
   2. ANS: A  PTS: 1  REF: PS 96

3. A set of well-defined instructions used to perform a task.
   3. ANS: D  PTS: 1  REF: PS 96

4. Finding the balance between image quality and image file size.
   4. ANS: B  PTS: 1  REF: PS 94